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Learning outcomes

❑Become familiar with the CSD.

❑Which subsets of the CSD are available, how to access them 
in ConQuest, Mercury and the CSD Python API, and how they can help 
you in your research.

❑How to visualise porous materials effectively in Mercury.

❑How to analyse pore space in your structures using Pore Analyser.

❑About applications of the disorder visualization feature, including 
recent advances and integrations with other functionality available in 
Mercury.

❑And more Mercury tips and tricks!
We will make the 

recording available to you 
in the next few days.
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Publication year

The Cambridge Structural Database

Structures 
published 
that year

Structures 
published 
previously

• Every published structure
• Inc. ASAP & early view

• CSD Communications

• Patents

• University repositories

• Thesis

• Every entry enriched and 
annotated by experts

• Discoverability of data and 
knowledge

• Sustainable for 60 years
• A trusted CoreTrustSeal 

repository

CSD Refcode: JEKNOC16. 
The 1.25 millionth CSD 

structure determined in 2023 
and a 3DED structure!. 

1 3 8 0 1 4 6
XOPCAJ



CSD Refcodes

What is JEKNOC16?
• A CSD Refcode
• A database reference 

code
• Containing 6-8 

characters
• Used to identify 

entries in the CSD

Refcode families
• The same substances are 

assigned the same 6 letter code 
plus an additional 2 numbers
• Polymorphs
• New determinations or re-

refinements of the same 
substance

• Determinations at different 
temperatures/pressures 

• Stereoisomers or different 
solvates, co-crystals, etc are 
assigned different refcode 
families

CSD Refcode - 
JEKNOC16

Some interesting refcodes are: KITTEN, BATMAN, DISNEY, GAUTAM, GLYCIN

Porous materials refcode families
• Different solvents or adsorbates would be 

assigned to different refcode families, even though 
the framework might be the same.



Curation

https://www.ccdc.cam.ac.uk/discover/blog/how-your-structure-is-curated-in-the-csd/

A combination of manual and automated curation

Information added
•Melting points
•Bioactivity details
•Natural source data
•Oxidation states
•Polymorph families

Identifier assigned
CCDC number, CSD Refcode
CCDC 236078, CSD-ETEXIK

Naming: 2-((Diphenylmethyl)sulfinyl)acetamide
Synonym: 2-(Benzhydrylsulfinyl)acetamide; Modafinil; Provigil 

Linking: DrugBank: DB00745
For Stereoisomer see KAHVUL

Bond assignments
Disorder resolution

Publication details 

E

Information extracted from CIF
Spacegroup:  P21/n
Cell: a 20.9610(10)Å b 9.7061(5)Å c 20.8940(10)Å, 
α 90° β 139.3360(10)° γ 90°

Structural: Atom coordinates, ADPs

Experimental information: Temperature, 
recrystallisation solvent, crystal colour, 
crystal habit

R factor: 4.2%

E

New for 2025

• Publication titles

• Enhanced refinement properties 
(including wR2, GooF, Max Shift, 
Residual density max/min)

• Predicted properties (including 
HOMO-LUMO gap, Singlet and Triplet 
state energies)

• Calculated properties (including total 
surface area, geometric volume, pore 
limiting diameter, max pore 
diameter)

Chemically meaningful 2D 
Diagrams



Inside the Cambridge Structural Database

Metal-Organic
• Metal Organic Frameworks
• Models for new catalysts
• Porous frameworks for gas storage
• Fundamental chemical bonding

Organic 
• Drugs
• Agrochemicals
• Pigments
• Explosives
• Protein ligands

Not Polymeric
88%

P
o

lym
eric: 12%

Organic
45%

Metal-Organic
55%

At least one transition metal, 
lanthanide, actinide or any of Al, 

Ga, In, Tl, Ge, Sn, Pb, Sb, Bi, Po

Single 
Component

58%

Multi 
Component

42%

ligands

ligands

Links and subsets 
• DrugBank
• Druglike 
• MOFs
• PDB ligands
• PubChem
• ChemSpider
• Pesticide PDB

Additional data
• 14,019 polymorph families
• 176,704 melting points
• 1,127,300 crystal colours
• 1,005,205 crystal shapes
• 32,100 bioactivity details
• 14,344 natural source data
• > 400,000 oxidation states

The CSD is a database of all the published organic and metal-organic experimental crystal structures



ASUXAP

ADONIU

ABEXEO

1D: >36k 2D: >27k

3D: >33k

Inside the CSD



Exploring coordination polymers in the CSD

Graphic created using Flourish and CSD Python API

Metals in the CSD MOF subset

• Over 100k have been synthesized.

• Growing potential applications, 
each with unique property 
requirements.

• Materials informatics using data in 
the CSD can help to focus research 
efforts to find the right MOFs for 
each application.



Industrial applications

• Energetic materials

• Ferroelectricity

• Catalysis

• Gas storage

• Gas separation

• Detection and sensing

• Batteries

• Drugs

• Semiconductors

• Filtration

• Carbon capture

Using materials informatics to support materials development

Systematically 
search the 

existing landscape 

Identify patterns 
to spark further 

investigation

Predict future 
successes and 

risks

Focus 
experimental 

efforts

Data is the fuel 

=

Catalysts in the CSD



Search, visualise, analyse and communicate structural data
Insights into molecular and crystal shape and interactionsCSDCore.

Medicinal & Computational Chemists  Crystallographers & Structural Biologists  Solid Form & Crystallisation 
Scientists  Functional Materials Scientists  Educators  Industry and Academia

Deposit, publish, access and visualise structural data
Free functionality to share and learn from structuresCSDCommunity.

Design of new molecules Insights from predicted  
structure landscapes

Anticipate particle 
properties and behaviour

2 Donors
2 Acceptors

Assessment of solid form 
stability and properties

CSDDiscovery. CSDMaterials. CSDParticle. CSDTheory.

The CSD Portfolio today



Using the CSD for porous materials

Mercury

ConQuest

Searching

WebCSD /Access Structures

Visualisation

Structural Analysis

CSD 
Python API

Mercury
Void and pore 

analysis
Guest analysis



What can you do with a licence?

• Supporting research: The CSD Python API 
enables bulk access to the CSD and large-
scale structural surveys to advance your 
research.

• Responsible data use: We encourage and 
support use for research and analysis, but 
redistribution and large-scale publication are 
restricted to protect the CSD’s sustainability.

• Publication guidelines: Small extracts and 
visualizations can be shared, but full datasets 
and CSD derived models require permission. 

• Supporting you: More information is 
available on our website, but if in doubt, 
contact us—we’re happy to help!

https://www.ccdc.cam.ac.uk/solutions/csd-licence/                                      support@ccdc.cam.ac.uk

https://www.ccdc.cam.ac.uk/solutions/csd-licence/
https://www.ccdc.cam.ac.uk/solutions/csd-licence/
https://www.ccdc.cam.ac.uk/solutions/csd-licence/


Agenda

• Show One: Introduction to the CSD and porous materials in the 
database

• Show One: Case studies from Prof. Maria Celeste Bernini
• Show One: Mercury functionality for porous materials
• Try One: Hands-on exercises
• Explore More: More tips and tricks for porous materials and case 

studies
• Explore More: Quiz and summary
• Extra time: More time for hands on and Q&A

We are recording today's 
session and will make the 
recording available to you 

in the next few days



Complex structures and searches

P. Z. Moghadam, A. Li, S. B. Wiggin, A. Tao, A. G. P. Maloney, P. A. Wood, 
S. C. Ward, D. Fairen-Jimenez, Chem. Mater., 2017, 29 2618-2625, 
DOI: 10.1021/acs.chemmater.7b00441



How to search in ConQuest

Results

Results 
view 

options

File menus

Tab options/views

Search options

Learn more 
in this self-

guided 
workshop

1. Build a Query: 2. Click search and select 
filters: do you need to 
restrict your search?

what do you 
want to find?

3. Visualise and analyse 
results: what can you 
learn from this data?



How to search in ConQuest

Results

Results 
view 

options

File menus

Tab options/views

Search options

Learn more 
in this self-

guided 
workshop

1. Build a Query: 2. Click search and select 
filters: do you need to 
restrict your search?

what do you 
want to find?

3. Visualise and analyse 
results: what can you 
learn from this data?



Using the subsets in ConQuest 
Restrict a 
search to 
a subset

1 Load a subset in the hitlists2

NEW!
Watch on 
YouTube



Using the subsets in the CSD Python API 

CSD Python API 
documentation 
and cookbook

Learn about 
searching 

with the CSD 
Python API in 

this free 
CSDU 

module



Mercury Overview

AABHTZ

Explore over 
1.35 million 

curated 
structures

More advanced 
functionality to analyse 

and learn from structures

v

Display options to 
visualise and 

navigate 
structures

Learn on demand 
with the CSDU 
module!



Using the subsets in Mercury 



Using your own file
• File > Open – to open one of your own files for example a CIF

• Edit > Auto Edit Structure to assign bond types

• File > Auto Edit Structure on Load to automate



AQOLAVAABHTZ

Lots of display and
analysis options!

Watch the 
video on 
creating 

personalised 
styles



Features for effective visualization

• Create files for 3D print

• Create high resolution 
images and frames for 
video or gifs

Print with your 3D printer 
or at a 3D printing service!

Example of 3D 
printed 
structure of 
CSD Refcode 
SAHYIK



Polymeric bond representations

In Mercury, 
polymeric 
bonds are 
drawn 
alternating 
long and 
short lines.



Polymer Expansion

By Whole unit 
It will add an additional 

repeat of the initial 
crystal chemical unit to 

the structure 

By Sub unit
it will add atoms and 
bonds up to the next 

polymeric atom or 
bond in the structure.



Multiple Structures
Use Multiple 

Structures for 
structure 

comparisons. 
Structures 
can be in 
different 
colours – 

helpful when 
overlaying 
structures.

TOP TIP!

TOP TIP!



Crystal Packing
Use Packing 
to compare 

larger 
structural 

units – 
helpful if 
polymer 

repeat unit is 
not identical.

Use Default 
view 

for(initial) 
alignment.

NEW



Structure Overlay
Select pairs 
of atoms in 
the same 
structural 

environment. 
The more 

pairs you use, 
the more 

realistic the 
RMS value 

will be.



Structure Overlay
Select pairs 
of atoms in 
the same 
structural 

environment. 
The more 

pairs you use, 
the more 

realistic the 
RMS value 

will be.



Exploring voids



Pore Analyser

Lev Sarkisov*, Rocio Bueno-Perez, Mythili Sutharson, and 
David Fairen-Jimenez, Chem. Mater. 2020, 32, 23, 9849–9867

Watch the 
video



Crystal Packing Feature Search

• Perform a substructure search.

• Investigate conformations of 
molecules or bonded fragments.

• Search for non-covalent 
interactions such as - or 
hydrogen bond interactions.

• Search for particular spatial 
arrangements of functional 
groups.

• Search for particular spatial 
arrangements of molecules.



Additional search functionality



Use for structure analysis



Calculate powder pattern

How are the patterns calculated?
• Fundamental calculation
• No one algorithm exists
• Series of steps need to be taken 

based on the theories of how X-
rays interact with 3D lattices. 

See the book "Fundamentals of 
Crystallography" by C. Giacovazzo, et 
al. for an overview.​



Calculate powder pattern



AQOLAVAABHTZ

Read the 
publication on 
symmetry tools

Lots of display and
analysis options!



Data fields

1 2 3

4



Data fields in the CSD Python API

(Entry API Module) 
https://downloads.ccdc.cam.ac.uk/documentation/API/modules/entry_api.html

The new properties can also be accessed 
using the CSD Python API from the 
Entry Module.



Visualizing disorder

• Functionality available when 
you load a CIF into Mercury and 
for structures in the CSD:
• Visualise the different disorder 

models.

• Visualise the contacts for each 
disorder model.

• Works in combination with other 
functionality, such as Edit, viewing 
and selecting hydrogen bonds, 
displaying Voids, Pore Analyser, 
Mogul, CSD-Materials & CSD-
Particle tools.

NEW



Visualizing disorder 

If cif, load from File 
> Open, then apply 
bond types via Edit 
> Auto-Edit Improved 

colouring and labelling 
options

Toggle the 
disorder options

x = occupancy
Example of combination 

with hydrogen bonds

Note: you can have more 
disordered groups and more 
than two options each.

Check CSD Entry JAZPOT!



Demo of Mercury

Search and analysis of polymeric structures in Mercury

We will:

• Use Mercury to visualise the polymeric frameworks of LnBTC (Ln = 
lanthanoid, Y) compounds

• Compare structures with a Structure Overlay

• Calculate Pore properties

• Simulate and compare PXRD patterns
We are recording today's 
session and will make the 
recording available to you 

in the next few days

BTC



Try One
It’s your turn!

• Try one example from the handout

• Your tutors are on hand to help 
you!

• To ask questions during this time 
type a message in the chat box

• If you finish early, try the other 
example or try analyse your 
structures

https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops

link to webpage

lin
k 

to
 h

a
n

d
o

u
t

REC

https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops
https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops
https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops
https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops
https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops
https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops
https://info.ccdc.cam.ac.uk/2025-autumn-virtual-workshops


Functionality in the CSD Python API

Find more 
functionality using 
the search bar!

https://downloads.ccdc.cam.ac.uk/documentation/API/search.html?q=



Solvate Volume

Solvate Analyser enables to visualize the volume 
occupied by inclusion molecules such as solvates



Disorder and Solvate Analyser

• Solvate Analyser works with disorder producing different results 
based on the disorder group selected

CSD Entry LIFNOG

Space calculated with different disorder groups active.



Disorder and Mogul
Mogul provides precise information 
on preferred molecular geometries. 

• Enables you to validate the chemistry of 
your structure against the experimental 
data in the CSD

On-demand 
training 
module

To see the results 
for different 
disorder options: 
• Toggle the 

disorder button
• Then use Mogul 

Geometry 
Check as usual

• Repeat for the 
other options

A1

A2

Bruno et al., J. Chem. Inf. 
Comput. Sci., 44, 2133-2144, 2004

CSD Entry WEBDEQ



Disorder and Mogul

A1

A2

On-demand 
training 
module

To see the results 
for different 
disorder options: 
• Toggle the 

disorder button
• Then use Mogul 

Geometry 
Check as usual

• Repeat for the 
other options

Bruno et al., J. Chem. Inf. 
Comput. Sci., 44, 2133-2144, 2004

CSD Entry WEBDEQ



Disorder and Hydrogen Bond Statistics

Hydrogen Bond Statistics
• Interactions geometries in the context 

of million+ crystal structures in the CSD

• Analysis of the usual- or unusual-ness 
of observed hydrogen bond 
lengths/angles in a crystal structure

CSD Entry REDHEO10

A1 & A2 disorder states
(0.815:0.185 occupancies)

A1

A1

A2

A2



Disorder and Hydrogen Bond Propensities 

• Hydrogen Bond Propensities
•Predict likely hydrogen 
bond pairings and 
donor/acceptor coordination 
                             likelihoods 

•Assess crystal forms, e.g. 
identifying sub-optimal 
hydrogen bonding or under-
/over-use of donors and 
acceptors

•Explore relative likelihoods 
of putative h-bond networks 

CSD Entry CATVOM

A1 A2

A1 & A2 disorder states
(0.78:0.22 occupancies)

• A1 low propensity pair, 
donors used optimal # 
times

• A2 higher ranked pair, 
less pairs, under-used 
donor

Other tools include Full Interaction 
Maps (FIMs) and Aromatics Analyser



CSD MOF Collection

• Complements our CSD MOF 
subsets embedded in CSD 
Portfolio

• A good starting point for high-
throughput analysis

• 12,505 3D porous MOFs
• All 3D MOFs containing over 10 % 

void space

• Converted to space group P1

• Non-bonded solvent removed

• Missing hydrogen atoms added

CSD EntryMOF Collection Entry



CSD MOF Collection

• The CSD MOF Collection contains reference 
spreadsheets

• Allows further categorisation within the 
collection

• The CSD MOF Collection has a Creative Commons 
licence: CC BY-NC-SA 4.0

• https://www.ccdc.cam.ac.uk/free-products/csd-
mof-collection/ 

• https://doi.org/10.1016/j.matt.2021.03.006 

https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://www.ccdc.cam.ac.uk/free-products/csd-mof-collection/
https://doi.org/10.1016/j.matt.2021.03.006
https://doi.org/10.1016/j.matt.2021.03.006


CSD and ICSD

• Porous materials encompass 
structures that may be 
considered inorganic, metal-
organic or organic

• It is possible to search for 
entries in both the CSD and 
ICSD using Access Structures

• Joint deposition system too!



Creating knowledge from the collection



A wealth of structures, stories and possibilities

CSD one million special issue
• 33 articles from industry and academia

The CSD - A wealth of knowledge gained from a million structures. CrystEngComm, 2020,22, 7131-77502
The CSD. C.R.Groom, I.J.Bruno, M.P.Lightfoot and S.C.Ward, Acta Cryst. (2016). B72, 171-179 DOI: 10.1107/S2052520616003954

Legacy and Future Impact of the 
Cambridge Structural Database: A 
Tribute to Dr. Olga Kennard - special 
issue
• 29 articles from industry and academia



More case studies



Augmented reality?
DigiMOF – a database of properties for 
MOFs found in the CSD, data mined from 
journal articles using ChemDataExtractor

Lawson T. Glasby, Rama Oktavian, Kewei Zhu, Joan L. Cordiner, Jason C. Cole, Peyman Z. 
Moghadam, J. Chem. Inf. Model. 2023, 63, 19, 5950–5955



How to cite the tools seen today

• Mercury
Mercury 4.0: from visualization to analysis, design and prediction
C. F. Macrae, I. Sovago, S. J. Cottrell, P. T. A. Galek, P. McCabe, E. Pidcock, 
M. Platings, G. P. Shields, J. S. Stevens, M. Towler and P. A. Wood, J. Appl. 
Cryst., 53, 226-235, 2020
DOI: 10.1107/S1600576719014092 

• CSD
The Cambridge Structural Database
C. R. Groom, I. J. Bruno, M. P. Lightfoot and S. C. Ward, Acta Cryst.(2016). 
B72, 171-179
DOI: 10.1107/S2052520616003954

• MOF subset
P. Z. Moghadam, A. Li, S. B. Wiggin, A. Tao, A. G. P. Maloney, P. A. Wood, 
S. C. Ward, and D. Fairen-Jimenez, Chemistry of Materials 2017 29 (7), 
2618-2625
DOI: 10.1021/acs.chemmater.7b00441 

More reference 
papers for

CSD Software



What we have learnt

✓Become familiar with the CSD.

✓Which subsets of the CSD are available, how to access them 
in ConQuest, Mercury and the CSD Python API, and how they can help 
you in your research.

✓How to visualise porous materials effectively in Mercury.

✓How to analyse pore space in your structures using Pore Analyser.

✓About applications of the disorder visualization feature, including 
recent advances and integrations with other functionality available in 
Mercury.

✓And more Mercury tips and tricks!



How many points did you get?

Let us know in 
the chat!



Want to explore more?

https://www.ccdc.cam.ac.uk/community/training-and-learning/

CSDU

• Free
• Completion certificate upon 

passing a final test.
• In-depth review of Mercury 

and more software and 
functionality.

Self-guided
workshops

Training and learning

• Covering use cases with guided 
examples.

• Including examples from today 
as well as other CSD Software.

Learn on demand 
with free online 
training courses

CSD Python 
API

Basics of
Mercury WebCSD

Videos

YouTube 
channel

And more!

REC



Want to explore more?

CCDC Virtual Workshops
• 21st October – How to Use Particle Informatics Tools 

to Connect Crystal Structure to Particle Behaviour

• 4th November – How to Use the Docking Software 
GOLD to Perform Virtual Screening Simulations

CCDC Webinars
• 13th November - Using general purpose force fields in 

solid form studies

• 20th November, Panel – Frontiers in MOFs: Creating 
Real-World Solutions with MOFs

Check our Events online for more 
virtual and in person events.
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